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Abstract

Cave-dwelling animals have evolved a series of morphological and behavioral traits to adapt to their perpetually dark and food-sparse
environments. Among these traits, foraging behavior is one of the useful windows into functional advantages of behavioral trait evolution.
Presented herein are updated methods for analyzing vibration attraction behavior (VAB: an adaptive foraging behavior) and imaging of
associated mechanosensors of cave-adapted tetra, Astyanax mexicanus. In addition, methods are presented for high-throughput tracking of
a series of additional cavefish behaviors including hyperactivity and sleep-loss. Cavefish also show asociality, repetitive behavior and higher
anxiety. Therefore, cavefish serve as an animal model for evolved behaviors. These methods use free-software and custom-made scripts that
can be applied to other types of behavior. These methods provide practical and cost-effective alternatives to commercially available tracking
software.

Video Link

The video component of this article can be found at https://www.jove.com/video/59099/

Introduction

The Mexican tetra, Astyanax mexicanus (Teleostei: Characidae), is unique among fishes for having two radically distinct alternative morphs - a
sighted, surface-dwelling morph and a blind, cave-dwelling morph comprised of several distinct populations1. Although different in morphology
and physiology, they are still interfertile2,3. These interfertile morphs appear to have evolved rapidly (~20,000 years)4, which makes them an
ideal model system for the study of rapid adaptation. Cavefish are known to have a suite of divergent morphological and behavioral traits
including increased density of taste buds, increased number of mechanosensors, foraging behavior tuned to a particular frequency of a vibrating
stimulus, hyperactivity, and sleeplessness. Many of these behaviors likely evolved simultaneously, some of which have been suggested to be
advantageous in the darkness of caves for foraging5 and conserving energy in dark and food-sparse environments6,7.

In many evolutionary model systems, it is difficult to acquire integrated knowledge on how animal morphology and behavior change in response
to the environment because most species are distributed across a continuous gradient in complex environments. However, the stark contrast
between the cave and surface morph Astyanax that evolved in highly contrasting environments delineated by a sharp ecotone has led to
Astyanax emerging as an excellent model to understand animal evolution. This makes it possible to more easily link genes and developmental
processes with adaptive traits and selection in the environment. Furthermore, recent biomedical investigations of these traits in Astyanax has
shown that these traits may parallel human symptoms8,9,10. For example, loss of sociality and sleep, and gain of hyperactivity, repetitive behavior,
and cortisol level are similar to what is observed in humans with autism spectrum disorder8.

To address the complex co-evolution of many behaviors and morphological traits, it is advantageous to assay many of them to highlight
underlying genetic and molecular pathways. Presented herein are methods for characterizing the degree of cave-type behavioral phenotypes
of surface, cave, and hybrid morphs of Astyanax. The focal behaviors analyzed to characterize phenotype are cave-adapted foraging behavior
(vibration attraction behavior, referred to henceforth as VAB), and hyperactivity/sleep duration11,12. Also presented is an imaging method for the
sensory system associated with VAB13. Recently, many open-source tracking software for running behavioral assays have become available14,15.
These work very well for short videos, less than 10 minutes long. However, it becomes problematic if the video is longer because of intense
computation/tracking time. Capable commercially available software can be expensive. The methods presented mainly use freeware and
therefore are considered cost-effective and high-throughput methods. Also included are representative results based on these methods.
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Protocol

All procedures are performed following the guidelines described in "Principles of Laboratory Animal Care" (National Institute of Health publication
no. 85-23, revised 1985) and the approved by University of Hawai'i at Manoa Institutional Animal Care and Use Committee animal protocol
17-2560-3.

1. Vibration attraction behavior (VAB) assay ( ≤ 10 min for entire recording procedure)

NOTE: Use an infrared sensitive camera or build an infrared camera by modifying a USB webcam. To modify a USB webcam, see a
detailed description presented by the Keene Lab in this cavefish issue at JoVE (From this A. mexicanus issue), or a brief description in the
Supplementary Materials.

1. Recording setup
1. To ensure that the camera remains in position, still, and at the proper focal length from the subject(s) being recorded, build a black box

frame out of polyvinyl chloride (PVC) pipes, measuring 120 cm H x 45 cm L x 90 cm W.
2. After construction of the frame, cover it with a plastic blackout curtain such as the one intended for hydroponic agriculture.
3. On top of the frame, put a black acrylic board with a window for the infrared camera at the center measuring the same diameter as the

C-mounted adjustable zoom lens. Inside this box, place the VAB assay equipment (Figure 1).

2. Vibration apparatus
 

NOTE: Vibrations are produced using a small function generator.
1. For the following methods, tune vibrations to an amplitude of 0.15 mm and a frequency of 40 Hz, which is the frequency that elicits a

maximum response of attraction5,16.
2. Connect the function generator to a horizontal facing speaker.
3. Attach a 7.5 mm diameter glass rod 14 cm in length to the dust cover on the face of the speaker by using hot-glue or a gasket

adhesive.
4. Perpendicular to this rod and facing downward, attach another 7.5 mm diameter glass rod 4 cm in length (Figure 1).

3. Behavioral assay
1. Acclimate an experimental A. mexicanus for 4 days in a cylindrical assay chamber filled with conditioned water (pH between 6.8 - 7.0,

conductivity approx. 700 µS, temperature approx. 22 ˚C) with a 12/12 L/D cycle. Check whether fish have acclimated by observing their
latency to forage. Longer latency than in their home tank indicates more acclimation time is needed. Throughout acclimation, feed once
a day with live Artemia nauplii.

2. The day prior to the day of the assay (after 3 days of acclimation), replace water in the assay chamber with fresh conditioned water.
3. On the day of the assay (after 4 days of acclimation), deprive experimental fish of food until after the assay is complete. Satiation will

change their response to vibrations.
4. Set the recording parameters in the VirtualDub freeware17: 15 frames/s, codec: x264vfw, recording duration: 3 min 30 s.
5. Prepare the vibration-emitting apparatus (see step 1.2) by tuning to 40 Hz. See Figure 1 for the explanation of apparatus. Rinse the

vibrating glass rod with deionized water to remove any water-soluble chemicals.
6. Working in the dark, place the assay cylinder on the recording stage illuminated by an infrared backlight in the black box and allow fish

to acclimate for 3 min.
1. After the 3 min acclimation, record 3 min 30 s of video. At the onset of the recording, insert the vibrating glass rod into the water

column (approx. 0.5 cm depth).
2. Avoid making any noise or vibrations while positioning the vibrating glass rod in the water as the fish can sense even the most

minor disturbances.
3. Finish this procedure within 30 s of starting the video recording to ensure that more than 3 min of the behavior is recorded.

7. Monitor the video while recording to ensure that no errors occur during this stage.
8. After finishing the recording, remove the vibrating glass rod from the cylindrical assay chamber and remove the assay chamber from

the recording stage. Repeat from 1.3.5 for the next fish.

4. Video analysis
 

NOTE: Converting the codec into a format that ImageJ can load only works on Windows operating system18 (Table 1).
1. Convert the compressed avi video into a readable format for ImageJ and set analysis parameters.

1. Install AviSynth_260.exe (https://sourceforge.net/projects/avisynth2/), pfmap build 178 (http://pismotec.com/pfm/ap/), and avfs
ver1.0.0.5 or ver1.0.0.6 (https://sourceforge.net/projects/avf/). Note that this method is program/version sensitive. The provided
website links will guide to the proper versions (Table 1).

2. Run batch file by double-clicking avs_creater.bat (supplemental file). Right click on the avs video file to be analyzed (select from
the avs files created by avs_creater.bat).

3. As video analysis using the Tracker plugin in ImageJ requires loading of the ImageJ macro (supplemental file
Macro_VAB_moko.txt), load the macro by drag-and-drop into the GUI shell of ImageJ. This macro will enable certain hot keys
for the following analysis.

4. In the working directory, create a new folder entitled "Process_ImageJ".
5. Right click on the .avs file to be analyzed (select from the avs files created by avs_creater.bat). Select the Quick mount option.

After the avs file is mounted as an external drive, open the avi file in ImageJ (the avi file has name ending with ".avi").
6. To set the scale of the distance measurement, select the diameter of the assay chamber by drawing a straight line across the

chamber using the Straight-line selection tool, then click Analyze > Set scale function. For example, input 9.4 cm if using a
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cylindrical dish with a 9.4 cm inner diameter. Check the radio box of Global in order to standardize the scale across all of the
following video analyses.

2. Convert to binary stack and run analysis.
1. Copy the assay chamber area by using the oval selection tool and then right click and select Image > Duplicate. At this time,

specify the range of frames to keep for further analysis, e.g., keep the first 2,700 frames after the vibrating rod entered the water
(at 15 fps this is exactly 3 minutes of video).

2. Clear the outside of the assay chamber and convert to a binary image by hitting the hot key 7 on the number bar of the keyboard.
3. After the background clears and a prompt appears, add a black dot at the center to indicate the position of the vibrating glass rod

by using the oval selection tool already set to black with the fill function. Click OK and a prompt will appear to move on to the
threshold adjustment.

4. Set the threshold to make a binary (all black and white) image of the fish. Adjust the threshold so that the fish can be seen in
entire video clips, and then select Apply.

5. Run the "Tracker" plugin by hitting the hot key 8 on the number bar. Set the minimum pixel size to 100 when prompted and hit
OK, generating the distance between the vibrating rod and the fish per frame for all 3 min of the binary video.

6. Adjust the mis-tracking generated by noise in video. To do so, check the Results window to identify the frames that return the
object number 3 or higher-indicating extra objects in those frames (e.g., particles in the water or the shade of the transparent arm
of the rod) in addition to the "rod" and "fish" in the frame. Remove any extra objects using the paintbrush tool.

7. Hit the hot key 9 on the number bar to export a binary stack of images of the entire video (in case it is necessary to reanalyze)
and an .xls file with coordinates and distance data (supplementary files CF01.xls, Threshold_CF01.tif and, Trac_CF01.tif). Hot
key 9 will also close all files associated with the current video. Repeat steps 1.4.2.1 through 1.4.2.6 for all replicates.

8. Run the macro script (supplementary file JoVE_2cmVAB_template_15fps.xlsm) to consolidate multiple Tracker result files
(.xls) into one spreadsheet and count the number and duration of approaches into a 1.5 cm area from the rod. Approaches not
lasting at least 0.5 s will not be counted. Change the parameters of distance and time counted as an approach according to
particular questions of interest.

3. Release the PC disk-space after finishing all analyses. Remove mounted files to free up disk-space - avi.avi and .avi.avs files
(extensions generated by the software)-by running a batch file multiunmountdel.bat in the same folder where avs_creater.bat was
run in the section 1.4.1.2.

2. Sleep and hyperactivity assay (24 h recording)

1. Behavioral assay
1. Acclimate five experimental fish for 4 days or more in each chamber of a custom-designed 10 L acrylic recording aquarium (45.9 cm x

17.8 cm x 17.8 cm; length x width x depth, respectively) filled with conditioned water (see step 1.3.1).
1. Separate each individual chamber with black acrylic boards making chambers equal in size, measuring 88.9 mm × 177.8 mm ×

177.8 mm (Figure 2). Be sure to cover each tank to prevent fish from jumping between chambers.
2. Set the programmable power timer to automatically turn on white LED light for 12 h, and off for 12 h every day during acclimation

period (for example, set the light on at 7 A.M. and off at 7 P.M.). This will entrain the circadian rhythm of fish (if it is susceptible to
entrainment).

3. Use opaque, white acrylic boards of similar dimension to the 10 L tank as diffusers to pass white and infrared light through in
order to provide diffuse light with even intensity across all tanks.

4. Throughout acclimation, feed once a day with live Artemia nauplii and provide aeration through sponge filters in each aquarium.
 

NOTE: Ensure fish are fed at consistent times (i.e., 1x per day at 9:00 A.M.) as feeding time can also affect entrainment of
circadian rhythms19.

5. Check whether fish have become acclimated by observing their latency to forage. A longer latency than in their home tank
indicates more acclimation time is needed.

2. The day prior to the day of the assay (3 days or more of the acclimation), replace water in the assay chamber with freshly conditioned
water (see step 1.3.1).

3. Set the recording parameter in the VirtualDub software17: 15 frames/s, codec: x264vfw, recording duration: 86,400 s (24 h).
4. Turn on the infrared backlight behind the recording stage (see Figure 2). By observing the VirtualDub live image on screen, adjust the

position of each aquarium to make them face the USB camera.
5. On the day of recording, feed each fish with live Artemia nauplii, remove all sponge filters, and turn on the infrared backlight.
6. Start 24 h recording in the morning (for example, the start time is 9 A.M. and the finish time is 9 A.M. the following day). Start capturing

the video and secure the location to avoid a disturbance. Periodically check that the recording is running.
7. After 24 h, make sure that the video saved correctly. Transfer the video to the PC workstation to track and analyze the fish's behavior.

2. Video analysis
1. First, check the video quality by looking at the lighting. Check if there is one fish in each section, and if there are any foreign

movements that may cause mis-tracking.
2. Prepare the mask to avoid mis-tracking outside of the aquarium. Make two masks: one for 'even' and one for 'odd' fish, based on their

sequence order in the tanks.
3. Make two folders named "odd" and "even" for the masks described above. Move the tracking parameter file of SwisTrack in each of

these folders.
4. Open the tracking parameter file of SwisTrack tracking software (supplementary file Tracking_odd.swistrack or

Tracking_even.swistrack). Specify the path to the video file and mask file, then save and exit out of the tracking parameter file. Adjust
blob number and maximum pixels parameters in "Blob detection" and "Nearest neighbor Tracking" components, respectively, according
to the experiments.
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5. Double-click to run a script of win-automation software which will automatically open SwisTrack software (supplementary file
swistrack_1.exe, swistrack_2.exe, swistrack_3.exe or swistrack_4.exe- these are all the same executable files), which aids in
updating the adaptive background subtraction in SwisTrack.

6. Open Tracking_odd.swistrack or Tracking_even.swistrack in SwisTrack software to load the tracking parameter file. After loading
the parameters, press the run button to start tracking.

7. Within the initial 9,000 frames (600 s, i.e., first 10 min of the recorded video), check whether fish tracking is working by looking at the
adaptive background subtraction, binary mask, and nearest neighbor tracking in the component list of SwisTrack (see accompanying
video). Then select Adaptive background subtraction in the Component list.

8. Hit the R button on the keyboard to resume win-automation and leave the PC to track. Tracking will take 5 - 7 h per 24 h video for a
desktop with 4-CPU cores and 8 GB of memory. According to needs, run multiple SwisTrack processes (including odd and even arenas
of a single video file) up to the number of cores in the CPU. For example, 4-cores can handle 4 videos at once.

9. During this tracking, avoid using this PC for other purposes because win-automation program automatically moves the mouse pointer.
The initial 9,000 frames will be discarded in the following procedure.

10. Allocate 3 Perl script files (1.fillupGaps2.pl, 2.Calc_fish_id_moko_robust, and 3.pl, 3.Sleep_summary_4cm_movingWindow.pl)
to the folder containing the tracking files generated by SwisTrack in the 'even' and 'odd' folders (see step 2.2.3).

11. Clip one frame of the video from the video file using VirtualDub and import this clip as a photo into ImageJ. Select the length of the
aquarium (45.9 cm) in ImageJ and calculate pixel/cm ratio. Write the pixel/cm ratio in 1.fillGaps2.pl in a text editor program and save.

12. Launch CygWin program, a Unix emulator. Locate the SwisTrack folder that contains the 3 Perl scripts by using cd on the command
line.

13. Run the Perl script by typing Perl 1.fillGaps.pl. These three Perl scripts will assign each tracking file to a unique chamber of the
aquarium and analyze the sleep duration and swimming distance while the fish was awake. It will take 1-2 h to finish the analysis.

14. Assess the text file named Summary_Sleep.txt to determine if the number of frames dropped from the analysis is acceptably low;
missing fewer than 15% of frames is considered acceptable.

15. Copy and paste the analyzed results from Summary_Sleep.txt to a spreadsheet with the macro (supplementary file
Sleep_12hr12hr_TEMPLATE.xlsm).

16. Run the macro to extract the summary data of tracking files.

3. DASPMI or DASPEI staining of mechanosensory neuromasts

NOTE: DASPMI and DASPEI staining is light-sensitive and should be done in dark conditions. Following protocol is for both DASPMI and
DASPEI by using DASPMI as an example.

1. Staining protocol
1. For a total of 1 L of staining stock solution (25 µg/mL), add 0.025 g of DASPEI or DASPMI crystals to 1 L of dH2O and let it dissolve

overnight. Keep solution stored at 4 °C and protected from light.
2. Immerse the fish in 2.5 µg/mL DASPMI or DASPEI dissolved in conditioned water (see step 1.3.1) for 45 min in a dark environment at

22 °C.
3. After 45 min, remove fish from the DASPMI or DASPEI solution and anesthetize by immersion in an ice-bath of conditioned water with

66.7 µg/mL of buffered-ethyl 3-aminobenzoate methane sulfonate salt (MS222).
4. Mount fish in a Petri dish plate and photograph under a fluorescent microscope. Take z-stack images and save as .tif files for the

following analysis.

2. Image analysis using ImageJ
1. Inside the folder containing .tif files, paste a template of the ImageJ macro file (Neuromast_ImageJ.txt) and create a new folder

entitled "Process_ImageJ". In the ImageJ macro file, set the path to the current directory.
2. Launch ImageJ and open the macro by dragging the macro file into the GUI or by clicking File > Open and selecting the macro file.
3. Run the macro by clicking Macros > Run Macro. The macro will then automatically open a picture file to be analyzed. If the picture file

does not open, click Macro > File pick up.
4. For Neuromast quantification, select the region of interest using Polygon Tool.
5. Hit the hot key 5 to duplicate region of interest.
6. Use the Paint Tool to remove or add dots for extra or missing neuromast from the previous image and then hit 6. After hitting 6, two

new windows will appear: scheme of numbered neuromasts dots and a table with total neuromasts quantified.
7. Hit 7 to save both files: one file is stored as a .tif image file and the other is saved as an .xls file. After these files are stored, a new

picture file will open for analysis.
8. Consolidate the neuromast counts of each fish into one spreadsheet by running the macro script (SN_Number_Diameter.xlsm).

Representative Results

The results presented herein are representative examples of what can be acquired with the presented methods. Therefore, results can deviate
slightly from the ones presented here for both cavefish and surface fish depending on the experimental conditions.

Vibration attraction behavior
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Representative results for VAB can be found in Figure 3 for both cave and surface fish. Note the edge-following behavior in the surface fish
(Figure 3A; an attribute shared with cavefish) and the strong attraction of cavefish to the vibrating rod (Figure 3B). The peak attraction level was
observed near 35 Hz for cavefish (Figure 3D) but not surface fish (Figure 3C), representing a key difference in the behavioral phenotypes of the
two morphs. The peak in attraction around this frequency most likely represents the frequency of vibrations made by prey or food items20,21.

Sleep and hyperactivity assay

The criteria used herein to define sleep fit the response thresholds previously determined to be effective for Astyanax11. Sleep is characterized
by extended periods of quiescence and is defined as immobility of >60 s and elevated response threshold12,22,23. In comparison to surface fish,
shorter sleep durations occur in larval and adult cavefish11,12, therefore, sleep assays are an effective way to behaviorally phenotype Astyanax of
all ages. While cavefish showed less-sleep (Figure 4B, shorter sleep duration in cavefish), they are also hyperactive (Figure 4A).

DASPMI or DASPEI staining of mechanosensory neuromasts

Neuromasts are composed of sensory cells that can be easily stained with DASPEI or DASPMI and observed in vivo under a fluorescent
microscope. The presented result was the result of DASPMI staining. The number of superficial neuromasts is enhanced in the cranial region
of the cavefish in comparison with surface fish (Figure 5C,D), and both the size-a proxy of the number of the mechanosensory hair cells-and
number of superficial neuromasts are positively correlated with the level of vibration attraction behavior (number of approaches to the vibrating
rod: Figure 5A,B).

Software Analysis version website

avfs Activity/sleep Version 1.0.0.6 http://turtlewar.org/avfs/

Avisynth VAB Version 2.6.0 http://avisynth.nl/index.php/
Main_Page

Cygwin Activity/sleep Version 2.11.0 https://www.cygwin.com/

ImageJ VAB and DASPEI Version 1.52e https://imagej.nih.gov/ij/

pfmap Activity/sleep Build 178 http://pismotec.com/download/
(at “Download Archive” link at the
bottom)

SwisTrack Activity/sleep Version 4 https://en.wikibooks.org/wiki/
SwisTrack

WinAutomation Activity/sleep Version 8 https://www.winautomation.com/
(free stand-alone app for this
procedure)

Windows operating system VAB and Activity/sleep 7, 8 or 10 https://www.microsoft.com/en-us/
windows

x264vfw All analyses NA https://sourceforge.net/projects/
x264vfw/

Table 1. List of freeware used in these analyses, and source website.

 

Figure 1: Schematic of vibration attraction behavioral assay experimental equipment. A glass rod attached to a speaker is tuned to a
frequency of 40 Hz and submerged to a depth of approx. 0.5 cm at the onset of video recording. This figure is modified from Yoshizawa et al.5.
Please click here to view a larger version of this figure.
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Figure 2: Schematic of sleep assay experimental equipment. Tanks are custom-made from 0.7 cm thick transparent acrylic boards; septa are
0.3 cm thick completely opaque black acrylic boards. Opaque black acrylic boards are used for this part of the tanks so that fish cannot see each
other. (A) Top view: Note that the outer chambers of the tank have tilted inward septa to accommodate differences in camera angle. (B,C) Front
and side views, respectively. (D) Array of three tanks backlit with infrared light passing through a diffuser in order to homogenize the intensity of
light across all tanks. Note that each tank's orientation is adjusted so that all the movements of each fish in its respective chamber are visible.
Panel (C) and (D) are modified from16. Please click here to view a larger version of this figure.

 

Figure 3: Representative results of a 3-minute vibration attraction behavior assay. (A,B) Top view of the swimming path of surface fish (A)
and cavefish (B); redlines are traces of the path that the fish took during the 3-min video. The black dot at the center indicates the location of the
vibrating glass rod. wrMtrck ImageJ plugin was used to visualize the fish traces24. (C,D) Comparison of results from surface fish (C) and cavefish
(D) exposed to multiple frequencies of vibration. Each dot represents each fish. Dark shaded areas are interquartile range. Note that across all
frequencies, surface fish do not show notable attraction to vibration whereas cavefish show a maximum in attraction near 35 Hz. (C, D) Modified
from 16. Please click here to view a larger version of this figure.
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Figure 4: Representative results from several measures for activity analysis-Diurnal activity patterns in surface fish and cavefish.
(A-B) Day (yellow bars) and night (black bars) scores of swimming distance (m per 10 min, A), and sleep duration (1,000 s/12 h, B). Each bar
represents the mean ± standard errors of mean. Blue stars indicate the level of significance for statistical comparisons between surface fish (Sf)
and cavefish (Cf). Cavefish and surface fish have significantly different day-night activities. Two-way ANOVA statistics for each phenotype are:
for swimming distance (A) between surface fish (Sf) and cavefish (Cf): F1,399 = 185.8, P < 0.001, between day and night: F1,399 = 26.9, P < 0.001,
interaction between population and day-night: F1,399 = 3.6, P = 0.060 (not significant: n.s.); for sleep duration (B) between Sf and Cf: F1,399 =
237.9, P < 0.001, between day and night: F1,399 = 164.1, P < 0.001, interaction between population and day-night: F1,399 = 26.5, P < 0.001. For
both analyses, N = 200 and 201 for surface fish and cavefish, respectively. The difference between day and night activities were tested by post-
hoc paired t-tests with Bonferroni corrections and denoted by black asterisks. *** denotes P < 0.001. ** denotes P < 0.01. A subset of the data
was reused and updated from 11. Please click here to view a larger version of this figure.
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Figure 5: Representative results of the relationship between VAB and neuromast. (A,B) The relationship between VAB and neuromast
number and size in cavefish, surface fish, and the F1 hybrid progeny of surface fish x cavefish.Note that the normalized scores of vibration
attraction (square root of number of approaches) is positively correlated with neuromast abundance (Pearson correlation coefficient r = 0.62, P
< 0.001) and neuromast diameter (Pearson correlation coefficient r = 0.31, P < 0.01). Panel A and B are modified from5. (C,D) DASPMI staining
of neuromasts in the cheek region of (C) a surface fish and (D) a cavefish. Scale bar in inset (C) and (D) are 1.0 mm. Please click here to view a
larger version of this figure.

Supplementary Materials. Please click here to download this file.

Discussion

These presented methods are easy-to-access but can be complicated to perform due to the nature of its freeware origins. Therefore, it is highly
recommended to perform trial assays and analyses before any actual experimentation.

The rate of data generation can be rapid once the experimental and analytical framework are established. Once established, it is possible
to record two fish in 7 min for the VAB assay, 30 fish in 24 h for the activity/sleep assay, and one fish in 2.5 to 3 min for neuromast imaging,
starting from MS222 anesthesia to final image capture. The durations of the video and image analyses can vary considerably depending on the
performance of the computer used. By using a PC with a 4-core CPU and 8 GB of RAM, VAB analysis can take 5-7 min per fish, activity/sleep
analysis can take 6-8 h per group of 30 fish, and neuromast image analysis can take 5 or 10 min per fish (single side or both sides of images
of the cranial region, respectively). Commercially available tracking software (Table of Materials) is an alternative for video analysis. It is very
powerful in animal tracking but expensive (e.g., base software ~USD$5,000USD and multi-tracking module ~USD$4,000). At this moment, our
tracking methods seem to achieve comparable accuracy of tracking, especially for the activity/sleep analysis, i.e., missing frames are typically
lower than 15% of total frames. This method also showed a high reproducibility in four replicates (Supplementary Table 1). However, the
difficulty in developing this system without an understanding of basic coding in Windows OS and Linux/Unix OS must be acknowledged.

During fish acclimation periods, and before and during behavioral assays, it is essential to provide the best possible and consistent living
conditions for experimental fish. This includes feeding high-quality food at the same time and amount every day and maintaining high water
quality (low ammonia, nitrates, nitrites, and dissolved organics, ~ pH 7, and similar conductivity around 700 µS). It is also important to perform
assays in an area not disturbed by noises. Noisy footsteps, and clattering sounds may change behavioral responses and activity/sleep-patterns.
To reduce the level of damage to mechanosensory units while handling fish, it is helpful to use a fine-mesh fish net while transferring fish; this will
help to avoid damaging the mucus cupula of neuromasts.

https://www.jove.com
https://www.jove.com
https://www.jove.com
https://www.jove.com/files/ftp_upload/59099/59099fig5large.jpg
https://www.jove.com/files/ftp_upload/59099/59099fig5large.jpg
https://www.jove.com/files/ftp_upload/59099/Supplementary_Materials.docx


Journal of Visualized Experiments www.jove.com

Copyright © 2019  Journal of Visualized Experiments April 2019 |  146  | e59099 | Page 9 of 10

DASPEI dye has sublethal effects on the fish, but excessive exposure can result in toxic effects. For example, immersing the fish in the DASPEI
solution for 2 h will raise the chance of mortality during the recovery of post-anesthesia. DASPEI staining is light-sensitive and therefore should
be done in dark conditions.

As for freeware installation, AviSynth software, Avisynth Virtual File System (avfs), and Pismo File Mount Audit Package (pfmap) required
specific versions to work together cohesively. It was confirmed by this protocol that avfs (v1.0.0.5), AviSynth (2.6.0) and pfmap (1.7.8) work
together, but at least the latest pfmap build did not work for the file-mounting procedure. For this reason, pay attention to the software versions
(Table 1). VirtualDub works better under the 32-bit version instead of 64-bit. The setting of 15 frames per s provides a good time resolution and
does not require excessive storage volume (1.6 GB for a 24-h sleep assay video and 3 MB for a VAB video). For ImageJ, the major difficulty
can come from setting file paths in the macro. In Windows OS, the file path can be generally expressed as "C:Document\my Document\...". The
ImageJ macro runs under the Java environment and needs an extra "\" for the file path, that is, "C\:Document\\my Document\\...". Please see the
example ImageJ macro file. In addition, it may be necessary to install two plugins, Slice Remover and Object Tracker25, and assign the hot keys
(Keyboard shortcuts) 6 and 8, respectively, so that the analyses work seamlessly (Plugins > Shortcuts > Add Shortcuts…26). SwisTrack has a
function to set the tracking parameters, but it is possible that a freeze and/or crash may occur while setting the tracking parameters. It is better to
edit the parameter in a text editor app such as Notepad++. For details of parameter settings, please see27. The Cygwin (Unix emulator) installer
includes a package installer to install the Perl package, which is not included in the default install setting. It is recommended to specifically select
the Perl package during installation of Cygwin.

Although, this procedure is limited to a lateral line-based behavior (VAB) and swimming activity and sleep, this animal tracking system can
be adapted to other behaviors including stereotypic repetitive behaviors, social interactions, and the asymmetric usage (left/right) of cranial
neuromasts during foraging (laterality)13, although these methods may require shallow arenas such as those suggested by idTracker14. With
a suite of evolved behaviors, one may apply different scripts to analyze the tracked X- and Y-axes data and investigate different behavioral
patterns. This analysis pipeline is intended to provide a foundation to resolve the mechanism of the evolution in multiple behaviors, and also how
comorbid autism-like behaviors are regulated by genetic, epigenetic, and the environmental factors.
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